
FTIR Spectroscopy of an alkanethiol monolayer
Laboratories 11 & 12

Purpose.  This experiment has two goals:  (1) measuring the extent of order within the
alkanethiol monolayers you have made and (2) determining the tilt angle of the aliphatic chains.
We will accomplish these two goals by measuring the absorption spectrum of the C-H stretching
resonances for the alkanethiol chains.  These resonances occur in the 2800 cm-1 to 3000 cm-1

region and are best accessed using external reflection FTIR spectroscopy.

Background.  Measuring the absorption spectrum of a single layer of molecules can be
challenging even if the layer constituents are strong absorbers.  For the vibrational resonances we
will be measuring, the extinction coefficient is on the order of 100 L/mol-cm, making the
measurement even more challenging.  There are several “tricks” that we employ to obtain the
vibrational spectrum of an alkanethiol monolayer.

The simplest means for estimating the absorbance signal is with Beer’s law.
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Thus a high quality instrument will be
required for the measurement.  It is important
to remember that we are measuring the
reflectance and not the absorbance directly.
From the Fresnel equations recall that the
reflection coefficient for an interface increases
with increasing angle of incidence.  This means
that the transmission coefficient and thus the
transmittance, T, decreases with increasing
incidence angle.  Since A = -log10T, A for the
interface increases with increasing incidence
angle.  This concept is schematized in Figure 1.
The calculated A values are actually an
approximation based on the bulk refractive
index of alkanethiols.  A more complete
treatment of this issue is given in the attached
paper.  The point of this figure is to illustrate
that there is a significant benefit in terms of
signal size and thus S/N ratio for measuring
reflectance at high incidence angles.

Surface Selection Rule:  As suggested in
Figure 1, there is an advantage to controlling

Figure 1.  Top:  Reflectance and Transmittance curves
calculated for TE and TM modes.  Bottom:  A values
calculated from T curves in top panel.
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the polarization of the IR light that is incident on the substrate containing the monolayer.  This is
also true for a different reason.  There is a surface selection rule that prevents the incident
electric field from coupling to an adsorbate for a certain polarization.  This is true for TE
polarized light, where the oscillating image dipole generated in the substrate does not contain
components that can be mapped onto the Cartesian projection of the alkanethiol absorption
transition moments.  For the TE mode, the image dipole oscillates in the plane of the substrate
and thus couples to the delocalized electrons in the metal.  For TM polarization, the E-field at a
metal is perpendicular to the surface.  Thus the E-field of the light can only interact with a
transition moment near the surface of the metal if it has a component perpendicular to the
surface.  This is only true for the TM polarization.  This fact also tells us that the only active
infrared modes will be those where the change in dipole moment due to the vibrational motion
has a component normal to the substrate.

External Reflection FTIR
Fourier transform infrared spectrometry is a widely used means to measure the vibrational

absorption spectrum of many different types of samples.  Because this technique is based on
instrumental and chemical principles that should be familiar, we do not present an extended
discussion of this technique here.  The only unique aspect of the measurements that you will
perform with the Mattson FTIR is the use of an external reflection attachment.

The external reflection attachment offers enhanced absorption sensitivity for the
measurement of monolayer samples.  Greenler calculated how absorption factor (in this case
defined as (Ro-R)/Ro varies with incident angle and Figure 5 of his paper contains these results,
showing that absorption increases dramatically at near-grazing angles.  You will demonstrate the
origin of this enhancement through your experiments and the sixth homework assignment.  For
further detailed information on the principles of operation of an FTIR, consult any good
instrumental analysis text such as Ingle and Crouch.

Determination of order within the monolayer.  The infrared spectrum of alkanes has been
studied in excruciating detail and a great deal is understood about the relationship between band
position and mesoscopic structure within the sample.  For example, there are a family of
aliphatic C-H stretching resonances in the 2800 cm-1 to 3000 cm-1 spectral region.

Figure 2.  Schematic of external reflection attachment for the Mattson FTIR.  The angle of
incidence is fixed at 80º with respect to the surface normal.
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Sample Asymmetric CH2 stretch Symmetric CH2 stretch
Liquid alkane 2923 cm-1 2854 cm-1

Solid alkane 2918 cm-1 2849 cm-1

Alkanethiol monolayer 2916 cm-1 2848 cm-1

The band positions for each resonance are related to many factors.  From an intuitive
perspective, viewing the vibrational resonances as harmonic oscillators, the frequency of the
resonance will depend on the shape and width of the potential well.  In confined environments or
in those characterized by a large potential energy gradient, dE/dq, the band position is expected
to appear at a higher frequency compared to cases where there is less physical confinement or a
more shallow potential energy gradient for the attractive surface.  Among the factors that can
influence the relevant potential well shape are the relative amount of trans and gauche
conformers in the alkane chains and the details of interchain packing.  Because trans conformers
are more energetically favorable than gauche conformers, the transition for the trans form is
slightly lower in energy than that for the gauche form.  In terms of local environment, the closer
to a crystalline (lowest energy) environment the alkane chain can establish, the lower the
resonance energies will be.  Comparison of the values you obtain for your monolayers to those in
this table will provide some insight into the extent of ordering within your monolayer.  It is also
important to consider the width of the resonances.  The broader the bands, the larger the
conformational distribution associated with it.  The typical case is that the monolayer bands will
approximate those for a liquid alkane in both band position and width immediately after the layer
is formed.  After suitable annealing, the bands will exhibit a red-shift and narrowing to produce a
spectrum characteristic of a well-ordered alkanethiol SAM.

In addition to -CH2 bands, you will also observe -CH3 bands.  The position of all of these
bands is given in one of the articles we handed out in class (JACS 109, 3559-3568).  We don’t
consider the -CH3 stretches as much as the -CH2 stretches because of their position at the
monolayer terminus.   There is likely to be more disorder at the top of the layer than in the
middle of the layer.

Determination of Tilt Angle

Allara and Nuzzo utilized FTIR extensively to determine the orientation of molecules on a
surface.  (Langmuir, 1, 52-66).  I will not follow their description, as it is more complex than
necessary, but the treatment given below is exactly the same.   The main point of the treatment is
that the intensity of a mode is proportional to the square of the dot product of the transition
dipole moment, M, and the electric field, E, as shown in equation 1.  The fact that the E vector is
perpendicular to the plane of the surface implies that the intensity will vary with orientation

according to equation 2, where Z is the unit vector in the direction of the surface normal, and χ is
the angle between the transition dipole and the surface normal.  Thus the intensity of the

absorption band will vary with the square of the cosine of χ.

2)( EMI •∝ 1
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An isotropic monolayer will behave as if the angle with the surface normal were 54.7°.  You
can prove this in your homework.  Given this fact, you can easily obtain a relation between an

anisotropic spectrum and an isotropic one as shown in equation 3 where I stands for the intensity
of a particular mode.  Thus if you can calculate the intensity of an isotropic mode and measure
the intensity of an anisotropic mode, you can calculate the orientation of the mode with respect
to the surface normal.  (Note that I is directly proportional to absorbance.)

Calculation of the spectrum of the absorbance of an iostropic monolayer

We have already solved this problem in our treatment of
ellipsometry.  You will remember that we calculated the overall
reflection coefficient, Q, for both TE and TM polarization for a
system such as that shown in Figure 3.  Now you only need the TE
polarization.  The overall reflection coefficient for this system is
given in equation 4 where the variables are defined as they were in

ellipsometry.  To calculate the reflectivity, R, we take the square
of the overall reflection coefficient, Q.  The reflectivity of bare
gold, Ro, is simply the square of the Fresnel coefficient.  We can
then calculate a pseudo-absorbance as log (R0/R).   This will give
you the "absorbance" spectrum of an isotropic monolayer, because

the optical constants are those for an isotropic film.

Calculation of Molecular Orientation

The first step in determination of orientation is to calculate the ratio of absorbance for the
measured spectrum and the calculated spectrum.  Using this ratio, you can calculate the
orientation for a particular mode using equation 3.  In the case of octadecanethiol monolayers,
we are most concerned with the -CH2 stretches as these will provide details of the chain
orientation.  There are two -CH2 modes, the symmetric and asymmetric stretches (2848 and 2916
cm-1, respectively).  The symmetric mode is parallel to the plane containing the backbone of the
all-trans chain and perpendicular to the chain axis, while the asymmetric mode is perpendicular
to the plane containing the backbone of the chain.  By determining the angle between the two
stretches and the surface normal, we can calculate the tilt and rotation of the all-trans chain.

To determine the orientation, we start with the plane of the CCC backbone as the XZ plane.
This will give the direction vector of the symmetric stretch as (1i + 0j + 0k).  The direction
vector of the asymmetric stretch will be (0i + 1j + 0k).  In order to change the angle with respect
to the surface normal, we can tilt the molecule by angle θ or rotate the molecule about the chain
axis by the angle φ.  These angles are shown in Figure 4.  One can also cause the molecule to
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Figure 3.  Schematic
diagram of an IR beam
reflecting from a gold-film
interfact.  Multiple
reflections are not shown.
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precess about the Z axis, but this will not change the angle of the dipoles with respect to the
surface normal.  We need to know how these rotations will affect the orientations of direction
vectors.  First consider tilt in the XZ plane.  If we put the direction vectors at the origin, we will
get the results in equations 5 where x, y, and z are the direction vectors after tilt and xo, yo, and zo

are the direction vectors before tilt.  Next consider rotation about
the chain axis by the angle φ.  If we do this before tilting, the
molecular axis is the z-axis.  For the rotation about the molecular
axis, we get the equations listed in 6.  By sequentially applying
equations 6 and equations 5, we can transform the initial direction
vectors into the rotated ones given in equations 7.   (Note you must
do the rotation first and then the tilt.) Then we simply need to
determine the angle between the direction vectors of the transition
dipoles and the surface normal.  We will vary the angle of rotation
and tilt until the calculated angles match those determined by
equation 3.  Our only remaining task is thus to determine angles
between the direction vectors for transition dipoles and the surface
normal.  The angle between any two direction vectors, χ, can be
calculated using equation 8, where d and D are any two direction
vectors.   Of course the vector for the surface normal will be
(0i+0j+1k).

θθ

θθ

sincos

cossin

oo

o

oo

xzz

yy

xzx

−=
=

+=
5

o

oo

oo

zz

xyy

yxx

=
+=
+=

φφ
φφ

sincos

sincos
6

||||||||

||
cos

Dd
Dd •=χ 8

Figure 4.  Tilt and
rotation angles for an
alkanethiol.
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FTIR Measurements

Only the Mattson Research (black) and Infinity FTIR instruments will be used for this
experiment.  Both have MCT detectors and the Research instrument has a water-cooled source.
When you enter the lab, the FTIR’s will be on.  Log onto the computer and select the WinFirst
software.  If the Control Panel is not visible, it can be selected from the Tools menu.

To Load the Correct Procedure:

In the Control Panel choose Load Method… and select “reflecta.ini” and then Okay.
Then choose Spectrometer Set-up… and make sure that:

Number of scans for both the background and the sample = 1024
Resolution = 4 cm 

-1

Gain = 1 (Research) or Gain =  4 (Infinity)

To Collect and Save a background of your clean gold substrates:

Place the substrate over the opening on the top of the reflectance attachment, close the sample
compartment, and wait a couple of minutes to allow the compartment to purge (~5 minutes).

From the Control Panel select Background and then hit Scan.

Save the background to your Z: drive directory (File > SaveAs > Z:\filename).  The file will
automatically be given a .bkg extension.

To Load a previously saved Background:

Go to the Tools menu and select Background Viewer.  Type in the name of your background.
This backgound will be shown and automatically be used for all subsequent sample scans.

To Collect and Save a Sample Scan:

Place your sample over the opening in the reflectance attachment, close the sample compartment,
and wait for the compartment to purge (~5 minutes).

Load the background.  (Note:  the background used must have been collected using the same
parameters.)

From the Control Panel, select Sample and then press Scan.

Save the spectrum with an appropriate name to your Z: drive (File > SaveAs > Z:\filename).

Log off the computer when you are done but do not turn off the FTIR unless you are the last
group to use it for the day.
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Procedure

Week 1:

1. Clean 2 gold-coated substrates using the plasma cleaner and determine the complex
refractive index of one of them.

2. Immerse the slide for which you determined n and k in 1x10-3 M octadecanethiol in
ethanol for 30 minutes.  Remove it from solution and rinse copiously with ethanol.

3. While waiting for the monolayer to form, place the other clean gold slide on the FTIR
external reflectance sample holder.  We use the holder because it provides a reproducible
mounting surface and angle of incidence.  Measure the response of the clean, bare
substrate and save those data as the background spectrum.  Think carefully about the
spectral range over which you want to acquire the data.  Once you have completed this
measurement, place this substrate in a sealed vial and leave it for next week’s experiment.

4. Measure ellipsometric thickness of the monolayer formed from the 30 minute immersion.
Place the sample on the FTIR external reflectance mount and record its spectrum.  To
ensure reproducibility, record three different spectra.  Put monolayer back in the
deposition solution to anneal for a week.

5. Based on the signal intensities of the absorbance spectra and the literature given to you,
calculate the chain tilt angle for this monolayer.

Week 2:

1. Determine the complex refractive index of the substrate.  Record the background
spectrum of the bare substrate that you stored for a week in a vial.  Once those data are
recorded, clean this substrate in the plasma cleaner and acquire a second background
spectrum.  Determine the complex refractive index of the substrate after cleaning.

2. Take the slide that has been immersed in 10-3 M octadecanethiol in ethanol for one week.
Remove it from solution and rinse copiously with ethanol.

3. Measure ellipsometric thickness of the monolayer formed from the one week immersion.
Place the sample on the FTIR external reflectance mount and record its spectrum.  To
ensure reproducibility, record three different spectra.  Make sure you use the same
spectral range and resolution as you did in the first week.

4. Based on the signal intensities of the absorbance spectra and the literature given to you,
calculate the chain tilt angle for this monolayer.  Compare the values for tilt angle you
obtain for the two different experiments.


